SPATIAL DISTRIBUTION OF CELLS WITHIN THE
VOID VOLUME OF A CHITOSAN-COLLAGEN
SCAFFOLD

By

REVATHY SUBRAMANIAN

Bachelor of Technology in Chemical Engineering

Anna University

Coimbatore, Tamil Nadu

2007

Submitted to the Faculty of the
Graduate College of the
Oklahoma State University
in partial fulfillment of
the requirements for
the Degree of
MASTER OF SCIENCE
July, 2012
SPATIAL DISTRIBUTION OF CELLS WITHIN THE VOID VOLUME OF A CHITOSAN-COLLAGEN SCAFFOLD

Thesis Approved:

Dr. Heather Fahlenkamp
Thesis Adviser
Dr. Sundararajan V. Madihally
Dr. James E. Smay
Dr. Sheryl A. Tucker
Dean of the Graduate College
TABLE OF CONTENTS

<table>
<thead>
<tr>
<th>Chapter</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>INTRODUCTION</td>
<td>1</td>
</tr>
<tr>
<td>1. Tissue Engineering</td>
<td>1</td>
</tr>
<tr>
<td>1.2. Pulmonary Tissue Models</td>
<td>3</td>
</tr>
<tr>
<td>1.3. Blood Gas Barrier</td>
<td>4</td>
</tr>
<tr>
<td>1.4. Problem Statement</td>
<td>5</td>
</tr>
<tr>
<td>BACKGROUND</td>
<td>7</td>
</tr>
<tr>
<td>2.1. Anatomy of Lungs</td>
<td>8</td>
</tr>
<tr>
<td>2.2. Inflammation and Infections in Lungs</td>
<td>9</td>
</tr>
<tr>
<td>2.3. Tissue Engineering Overview</td>
<td>11</td>
</tr>
<tr>
<td>2.4. Scaffold</td>
<td>12</td>
</tr>
<tr>
<td>2.4.3.1. Methods for Scaffold Preparation</td>
<td>16</td>
</tr>
<tr>
<td>2.5. Cells</td>
<td>19</td>
</tr>
<tr>
<td>2.6. Existing Models for Lung Constructs</td>
<td>20</td>
</tr>
<tr>
<td>MATERIALS AND METHODS</td>
<td>22</td>
</tr>
<tr>
<td>3.1 Fabrication of Collagen-Chitosan Porous Scaffolds</td>
<td>22</td>
</tr>
<tr>
<td>3.1.1. Materials</td>
<td>22</td>
</tr>
<tr>
<td>3.1.2. Protocol</td>
<td>22</td>
</tr>
<tr>
<td>3.1.3. Investigating the Effect of Varying Collagen and Chitosan Content on Scaffold Properties</td>
<td>23</td>
</tr>
<tr>
<td>3.1.4. Scaffold Characterization</td>
<td>24</td>
</tr>
<tr>
<td>3.1.4.1. Porosity Measurement</td>
<td>25</td>
</tr>
<tr>
<td>3.1.4.2. Swelling Studies</td>
<td>25</td>
</tr>
<tr>
<td>3.2. Seeding Cells within the Porous Scaffold</td>
<td>25</td>
</tr>
<tr>
<td>3.2.1. Materials</td>
<td>25</td>
</tr>
<tr>
<td>3.2.2. Cell Culture and Preparation</td>
<td>26</td>
</tr>
<tr>
<td>3.2.3. Collagen Gel Preparation</td>
<td>27</td>
</tr>
<tr>
<td>3.2.4. Seeding Cells within the Scaffold</td>
<td>27</td>
</tr>
<tr>
<td>3.2.5. Experimental Design to Investigate the Effect of Collagen Concentration and Centrifugal Force on Cell Distribution within the Scaffold</td>
<td>27</td>
</tr>
<tr>
<td>3.2.6. Cell Seeding Efficiency and Viability within the Scaffold</td>
<td>29</td>
</tr>
<tr>
<td>3.2.7. Cell Spatial Distribution within the Scaffold</td>
<td>31</td>
</tr>
<tr>
<td>RESULTS AND DISCUSSION</td>
<td>33</td>
</tr>
<tr>
<td>4.1 Fabrication of Collagen-Chitosan Porous Scaffolds</td>
<td>33</td>
</tr>
<tr>
<td>4.1.1. Scaffold Optimization</td>
<td>33</td>
</tr>
<tr>
<td>4.1.2. Porosity Measurement</td>
<td>38</td>
</tr>
<tr>
<td>4.1.3. Pore Size Distribution</td>
<td>39</td>
</tr>
<tr>
<td>4.1.4. Swelling Behavior</td>
<td>39</td>
</tr>
</tbody>
</table>
# LIST OF TABLES

<table>
<thead>
<tr>
<th>Table</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Table 1. Experimental runs that varied the concentration of collagen and chitosan during scaffold preparation</td>
<td>24</td>
</tr>
<tr>
<td>Table 2. Collagen gel preparation</td>
<td>27</td>
</tr>
<tr>
<td>Table 3. A two-factor and two-level factorial design matrix to investigate the effect of collagen concentration and centrifugal force on cell growth and distribution within the scaffold</td>
<td>29</td>
</tr>
<tr>
<td>Table 4. Optimum cell seeding parameters</td>
<td>52</td>
</tr>
</tbody>
</table>
### LIST OF FIGURES

<table>
<thead>
<tr>
<th>Figure</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Figure 1. Classical strategy in tissue engineering with cells grown in a matrix under <em>in vitro</em> conditions.</td>
<td>2</td>
</tr>
<tr>
<td>Figure 2. Structure of alveolar and capillary barrier in lungs.</td>
<td>4</td>
</tr>
<tr>
<td>Figure 3. Lung anatomy with alveolar structure</td>
<td>9</td>
</tr>
<tr>
<td>Figure 4. A fixed cut lung specimen with cavities lined by heavy dark carbon deposits</td>
<td>11</td>
</tr>
<tr>
<td>Figure 5. Common <em>in vitro</em> approaches in tissue engineering</td>
<td>12</td>
</tr>
<tr>
<td>Figure 6. Structure of chitosan</td>
<td>14</td>
</tr>
<tr>
<td>Figure 7. Structure of collagen</td>
<td>16</td>
</tr>
<tr>
<td>Figure 8. Schematic of the experimental design to study the effect of collagen concentration and centrifugal force on cell growth and distribution in the scaffold.</td>
<td>28</td>
</tr>
<tr>
<td>Figure 9. Scaffold sectioned for measuring cell distribution</td>
<td>32</td>
</tr>
<tr>
<td>Figure 10. Effect of viscosity on chitosan concentration at 278 K</td>
<td>34</td>
</tr>
<tr>
<td>Figure 11. Scanning electron microscope images of six samples revealing the surface morphology</td>
<td>36</td>
</tr>
<tr>
<td>Figure 12. Influence of chitosan concentration on thickness of samples</td>
<td>37</td>
</tr>
<tr>
<td>Figure 13. Mean pore size of samples</td>
<td>38</td>
</tr>
<tr>
<td>Figure 15. Box plot shows distribution of pores within three sections, Bottom, Middle and Top, of the scaffold.</td>
<td>39</td>
</tr>
<tr>
<td>Figure 16. Cell morphology shows spatial orientation in a (a) 2D monolayer and (b) 3D collagen gel.</td>
<td>40</td>
</tr>
<tr>
<td>Figure 17. Images captured 24 hours after cell seeding, showing that cells are attached on the pore walls of the scaffold.</td>
<td>41</td>
</tr>
</tbody>
</table>
Figure 18. Spectrofluorometer reading on a) Cell seeding and (b) Cell viability.............43
Figure 19. Reference for various experimental conditions used during cell seeding. ......44
Figure 20. Cell distribution in Z direction after 24 hours of seeding. ......................45
Figure 21. Cell distribution in the Z direction after 72 hours of seeding..................46
Figure 23. Change in corrected fluorescent intensity 24 and 72 hours after seeding. ....50
Figure 24. Total number of viable cells in three sections of the scaffold after 72 hour of seeding .................................................................51
Figure A1. Analysis of pore size using ImageJ software...........................................63
Figure A2. Result window of ImageJ .................................................................64
Figure A3. Image processing using ImageJ..........................................................66
CHAPTER I

INTRODUCTION

1.1. Tissue Engineering

Tissue and/or organ failure due to injury or other type of damage is a major health problem and accounts for half the total annual expenditure in the healthcare industry in the United States [1]. Some invasive treatment options include transplantation and surgical repair. However, major damage to tissues or organs cannot be repaired. With these drawbacks in the current treatment options, tissue engineering emerges as a significant alternative or complementary solution. Cell transplantation is another alternative for replacing the damaged tissue [2]. Individual cells harvested from a donor patient are isolated and implanted in the patient. Isolated cells are expanded in vitro by tissue engineering techniques. With cell transplantation, the living donor does not have to sacrifice the entire organ, reduces immune rejection and cost of the procedure significantly.

Tissue engineering is an interdisciplinary scientific area that creates, repairs and/or replaces tissues and organs [3]. This field combines cells, biomaterials, and biologically active molecules.
The goal of tissue engineering is to produce a material that closely resembles in vivo conditions. Cells from a patient are seeded in a biomimetic matrix under controlled conditions (Figure 1). The matrix degrades or hydrolyzes while the cells grow into newly formed tissue [4, 5]. This technique is adapted for skin grafting, wound healing and cartilage replacement. With the emergence of stem cells, regenerative medicine has become possible [6].

Figure 1. Classical strategy in tissue engineering with cells grown in a matrix under in vitro conditions [7].

Some of the major challenges in tissue engineering lie in understanding various cell mechanisms, mass transfer requirements, and analyzing materials for designing scaffolds/templates. Many researchers have sought to design porous constructs using materials approved by Food and Drug Administration (FDA) such as chitosan and collagen. Porous constructs seeded with cells ex vivo, and expanded in culture, ultimately integrate into a segment of functional tissue by cell migration and proliferation. Extracellular matrix (ECM) secreted by cells, replace the biodegradable porous construct. Although many successful developments have been made in the area of tissue engineering such as skin and bladder [8-11], some limitations still hamper the ability to produce
thick and complex structured tissues. One main hurdle is inability to observe the distribution and migration of seeded cells throughout the scaffold [11].

Tissue engineering has started to gain importance in regenerative medicine. Lately, engineering tissue for in vitro applications has been recognized for its potential value. In vivo, the cell responses are regulated by local spatial cues such as extracellular matrix, neighboring cells and physical forces in three dimensions. Upon isolation from the host, the cells start displaying phenotypic instability [12]. Therefore, for a successful regeneration of tissue, a complete understanding of in vivo cell responses is required. In vitro systems are used for studying tissue-cell interactions, toxicology, and prescreening of drugs. In order to use in vitro systems for predicting in vivo results, the experimental conditions of in vitro systems are carefully set up to simulate in vivo environment. Traditional in vitro two-dimensional (2D) cell culture fails to capture in vivo cell responses, due to the lack of three-dimensional (3D) spatial cues. Two-dimensional cell cultures are also prone to external perturbations [13].

1.2. Pulmonary Tissue Models

Three pulmonary models developed for investigating the fundamental pathways for physiology and disease are (i) animal, (ii) ex vivo organo-typic culture and (iii) in vitro cell culture. Animal models are expensive and time consuming and do not always correlate with human studies.

Three-dimensional in vitro cell culture serves as a bridge between two-dimensional cell culture and animal models. This model has gained more interest as it provides a platform for toxicology screens and drug development [12]. The goal of this project is to develop a porous scaffold that can be seeded with cells throughout the matrix as a first step towards the development of a three-dimensional in vitro lung construct. The construct represents the thick capillary endothelium layer of the blood gas barrier in lungs.
1.3. Blood Gas Barrier

The overall efficiency of gas exchange depends on the structural and functional integrity of alveolar–capillary membrane. The structure of blood gas barrier is shown in Figure 2. Each alveolus is composed of capillary endothelium, alveolar epithelium, and interstitial cells. The alveolar (transports air) capillary (transports blood) layer is called a blood gas barrier with a gas exchange area of 50 to 100 m$^2$.

The thick capillary endothelium layer mostly consists of fibroblast cells and collagen. The thinner portion is made of alveolar epithelium and vascular endothelium. The endothelium layer has low permeability to larger molecules such as proteins. This configuration promotes the molecular diffusion as well as protects the interstitial layer from electrolyte transition.

![Figure 2. Structure of alveolar and capillary barrier in lungs [14].](image-url)
For sufficient gas exchange, over 20 million alveoli are present in an adult human lung. The alveolus is relatively dry in a normal lung. The alveolar fluid decreases or prevents the gas exchange across air-blood barrier, minimum of 0.2 μm in thickness.

1.4. Problem Statement

There is a need for tissue-engineered lungs that can be used to study disease and test pharmaceuticals [15]. The overall goal is to develop lung tissue constructs with capillary endothelium interface. As a first step to reach this goal, the following are the objectives set forth in this thesis.

a. Fabricate biocompatible, porous scaffolds for cell seeding

To best replicate the alveoli and capillary barrier, chitosan and collagen (type I) are chosen as scaffold materials. The combination of chitosan with other biomaterials such as collagen can have hybrid benefits on cell adhesion, cell differentiation and extracellular matrix formation. Lee et al. investigated the controlled release of TGF-β 1 in porous type I collagen-chitosan-GAG scaffolds [16]. The study concluded that the addition of chitosan to collagen (type I) improved the mechanical properties of scaffold by collagenases inhibition [16, 17]. In this project, 3D scaffold is fabricated by two stage lyophilization with intermediate chemical crosslinking. Both collagen and chitosan concentrations are varied to achieve a scaffold with desired properties related to scaffold thickness, average pore size, and porosity, such as a thickness less than 1000 μm, a pore size greater than 50 μm and a porosity greater than 50%. The pore size and thickness of the scaffold is measured using scanning electron microscope (SEM) and light microscope.
b. Characterize a seeding method that utilizes collagen gelation and centrifugation for uniform cell seeding throughout the porous scaffold.

Robin et al. investigated the effects of centrifugal force and centrifugation time on cell seeding in polyethylene terephthalate matrices [71]. Several design parameters such as porosity, cell seeding density, centrifugation time and speed were studied using two matrices of varied porosity. The study concluded that there was no significant difference in seeding efficiency with different porosities. Zhang et al. investigated a novel method for transforming growth factor, β1 (TGF-β1) DNA in chitosan/collagen scaffold [72]. The scaffold fabricated by freeze drying method was seeded with human periodontal ligament cells and monitored up to 14 days. Interconnected pores with a diameter of 200 µm and a porosity of 80% were produced.

Fibroblast cells isolated from adult skin are chosen as the model cell type to grow in the scaffold. The cells mixed in collagen solution (type I) are dynamically seeded by centrifugal force. The cells trapped in collagen gel are investigated for cell growth and distribution in the scaffold. All other factors such as scaffold geometry, cell density, time and temperature for centrifugation and incubation are held constant. The influence of collagen concentration and centrifugal force on cell seeding is investigated.

With the above objective, I hypothesize the following

a) The viscous nature of collagen gel traps the cells and prevents them from quick settling when centrifuged.

b) Centrifugal force increases cell penetration into the scaffold.

c) The influence of collagen solution and centrifugal force increases cell seeding efficiency and cell viability when compared to static seeding. In static seeding, the majority of cells attach to the top surface of the sample with low cell penetration.
CHAPTER II

BACKGROUND

Nearly 30 million patients in US are currently suffering from end-stage lung disease while 12.2 million adults are affected by chronic obstructive pulmonary disease (COPD) such as asthmatic bronchitis [18]. Pulmonary diseases are fourth in causing death [19, 20]. Despite the clinical and economic importance of COPD, the mechanisms and etiology are poorly understood [21]. Though, lung transplantation is the only definite treatment for terminally ill patients, donor shortage and immunosuppression limits its clinical impact [22].

Tissue engineering integrates engineering and life sciences in an attempt to generate functional pulmonary tissue. Porous three-dimensional scaffold plays an important role in guiding the cells to form a tissue or organ. The expanded cells adhere to the scaffold in three dimensions. Cells proliferate and secrete extracellular matrices which replace the scaffold. Developing three-dimensional in vitro model which replicates the lung architecture is extremely challenging. The unique lung parenchyma contains connections of alveolar units for airways and pulmonary circulation. Several strategies adopted to construct suitable scaffolds for lung tissue engineering are discussed in this chapter.
2.1. Anatomy of Lungs

A normal adult human lung absorbs oxygen from about 10,000 L of air/day. Air exchanged from atmosphere travels through the nasal cavity and trachea. The trachea bifurcates into two main bronchi entering right and left lung. The right lung divides into three lobes: upper, middle and lower. The left lung has two lobes: upper and lower. Upper left lobe includes the lingual homologous to the middle right lobe [15].

Central airways have trachea, right and left main bronchi, and major lobar bronchi. A main distinguishing feature of the airways is the presence of cartilage, forming a U-shaped structure anteriorly with fibrous posterior membranous sheath. Between the central and distributing airways are numerous segmental and sub segmental bronchi. The distributing airways have a central diameter of 3-4 mm with regular U-shaped cartilage. Peripheral airways have abundant smooth muscle in place of irregularly spaced cartilage [15].

Lack of cartilage distinguishes terminal bronchioles from upper respiratory system. Following the terminal bronchioles are respiratory bronchioles containing scattered alveoli. Respiratory bronchioles further divide into alveolar ducts and alveoli. The branching tree structure of lung allows an increase in cross-sectional area from size of a quarter at the trachea to the size of half a tennis court at the alveoli.
Lung is composed of epithelial cells, connective tissue, and smooth muscle cells arranged in specific architectural units. The primary function of lungs is gas exchange between air and blood at alveoli. The actual site of gas exchange occurs at alveoli sacs, present in alveolar clusters at the end of bronchial tree. Alveolar sacs with walls of 200 \( \mu \text{m} \) in diameter and capillary are separated by inter-alveolar septae, usually made of elastin.

### 2.2. Inflammation and Infections in Lungs

Chronic obstructive pulmonary disease (COPD) refers to two main lung diseases, chronic bronchitis and emphysema. The following might be one or more reasons for the obstructed or limited airflow pattern [24].

- Destruction of alveolar support which maintains patency of small airways, reduces elasticity of air sacs.
- Destruction of air sac walls results in fibrosis.
- Thick and inflamed walls of airways.
• Increase in mucus production due to accumulation of inflammatory cells in bronchi tends to clog airways.

Long exposure to lung irritants such as toxic gases and particles damages the lungs and airways (Figure 4). Among atmospheric pollutants, cigarette smoking is one of the primary causes for COPD in United States of America. Any particles deposited in lungs are removed by innate defense system along with macrophage through the mucociliary [25]. The protective barrier in tight junctions between epithelial cells is broken by chronic exposure to cigarette smoke. Epithelial disruption initiates acute inflammatory response [26]. Patients with chronic bronchitis are diagnosed with enlarged bronchial mucous glands and thickened bronchial wall [26]. Inflammation of bronchi produces mucus for a period of three months to two successive years with no underlying cause. Enlarged bronchial glands hamper airflow passage and scar the lungs leading to bacterial infections [26].

Nasal passage and oropharynx are normally colonized by microorganisms [27]. Lower sterile respiratory tract is aspirated with microbes from upper airways in healthy people. The host response removes the microbes and maintains sterility. Chronic cigarette smoke suppresses the defense mechanism. Some microbes invade the natural tissue barriers and produce infection [28].

COPD diseases such as emphysema or chronic bronchitis develop gradually over a period of time. Lung damage due to COPD is irreversible and greatly reduces patient’s quality of life [29]. Shortness of breath indicates the onset of COPD. The causes and mechanisms associated with pathogenesis of COPD can be studied by developing in vitro models. The models can also provide appropriate therapeutic regions. In vitro diagnostic test enables rapid differential diagnosis and excludes other suspected conditions such as pulmonary embolism, heart failure.
Tissue engineering plays a major role in providing biological scaffolding for the explanted primary cells to differentiate.

![Image](image.jpg)

Figure 4. A fixed cut lung specimen with cavities lined by heavy dark carbon deposits [30]

2.3. **Tissue Engineering Overview**

Cells with bioactive factors cultured in scaffolds generate functional engineered tissues for *in vivo* applications (Figure 5).
2.4. Scaffold

A scaffold is a framework with three-dimensional environ for the cells to grow, attach, proliferate, and migrate. Scaffold acts as a carrier for cells, growth factors and other bio-molecular signals to organize into tissues. The cells produce extracellular matrix molecules (ECM) and eventually form 3D structures as in native tissues. The materials and methods for scaffold preparation are chosen with care to mimic the structure and properties of tissue formation. Some of the properties include biocompatibility, porosity, pore size, surface properties, pH, surface charge, mechanical properties, and biodegradability. The following requirements are identified as crucial for production of tissue engineering scaffolds [32, 33].

a) Provide channels for oxygen and nutrients to reach cells deep inside the scaffold, and easy removal of waste products;

b) Biocompatible for cells to attach and proliferate;

c) Biodegradable and is eventually eliminated from the system;

d) Ease of reproducibility;

e) Porous enough to minimize diffusion constraints and allow uniform cell distribution for homogenous tissue regeneration.
2.4.1. Scaffold Materials

Biocompatible materials such as metals, ceramics and polymers have been used for surgical implantation. Metals and ceramics have their limitations when compared to polymers. Polymers are biodegradable and biocompatible when compared to metals and ceramics. Polymers are generally classified as synthetic and natural materials. Semi-synthetic smart materials, a hybrid of synthetic materials and oligopeptide sequences are rapidly emerging [34]. Ideally, the scaffold materials are chosen to mimic the native extracellular matrix secreted by cells.

Synthetic Materials

Synthetic materials such as poly (lactic-co-glycolic acid) provide good mechanical strength to withstand the in vivo forces. These materials are manufactured on a large scale. The mechanical and degradation properties can also be controlled with time. One of the greatest disadvantages in using these materials is poor recognition of cell signals.

Natural Materials

Natural materials have excellent physiological activities such as selective cell adhesion. The naturally derived materials have components similar to the natural extracellular matrix. The biological recognition for cell function is one of the advantages of natural materials. Though biodegradable natural polymers are abundant, reproducing the scaffolds can be difficult due to its structural complexity. Variation in degradation rates and poor mechanical strength are some of the disadvantages of using natural polymers [35].

2.4.2. Chitosan

Chitosan is a semi-crystalline polymer obtained by partial de-acetylation of chitin, found in exoskeletons of crustaceans (crabs, shrimps etc.). Chitosan is a linear polysaccharide containing β (1→4) linked D-glucosamine residues with a number of N-acetyl-glucosamine groups (Figure 6).
Chitosan molecular weight varies from 50 to 1000 kDa depending on the source and preparation procedure. The degree of de-acetylation ranges from 50 to 90%. Chitosan is extensively used for industrial applications based on film and fiber formation [3, 5, 36].

![Figure 6. Structure of chitosan [37].](image)

Chitosan is positively charged with pKa value of ~6.5 and is soluble in acidic to neutral solution. The charge density is dependent on pH and percentage of deacetylation. Bio-adhesive in nature, chitosan readily binds to negatively charged surfaces such as mucosal membranes. This property can be used for delivering biologically active polyanions such as DNA. Chitosan enhances polar drug transport across epithelial surfaces, and is biocompatible and biodegradable.

Chitosan is degraded by enzymatic hydrolysis with lysozyme, which appears to target acetylated residues [38]. The degradation products are chitosan oligosaccharides of variable length. Highly de-acetylated chitosan (e.g. >85%) exhibit the lowest degradation rates and may last several months in vivo, whereas samples with lower levels of de-acetylation degrade more rapidly.

Numerous studies are conducted on pure chitosan as a candidate for tissue engineering. Fibrous scaffold are appealing than foams and sponges as they closely simulate the native extracellular matrix [39].
Protasan is a trademark of FMC BioPolymer (Ewing, NJ). The polymer is a highly purified, water-soluble chloride with 75-90% deacetylation. The ultra-low impurities such as proteins and endotoxins allow a variety of in vitro and in vivo applications. The ultrapure medical grades of the polymer have been shown to be nontoxic [26]

2.4.3. Collagen

Collagen is a ubiquitously found natural material in the human body. The protein is responsible for maintaining structural integrity of many organisms [40]. It is one of the principle components of extracellular matrix, provides the environment for cells to grow, by releasing cell mediators such as growth factors [35]. A number of genetically distinct collagens peptides coiled around to form triple helix (Figure 7) have been identified [41-43]. Type I collagen is found in the dermis, tendon, bone and fibrous cartilage. It is the major component of the scar tissue. Collagen is primarily extracted from animal tissue such as rat tail, bovine tendon and calf skin. Along with its abundance and accessibility, collagen can also be cross linked to improve its mechanical properties. Some of cross linking techniques include chemical (glutaraldehyde, tripolyphosphate) physical (lyophilization) and enzymatic treatment [44]. The abundant, biodegradable and biocompatible collagen have contributed to the advancement of in vitro constructs. Three-dimensional (3D) collagen (type I) gel scaffolds are used in cell-ECM studies as engineered tissue substitutes or tissue equivalents [45]. Collagen based scaffolds have demonstrated highest potential for tissue regeneration [45-48]. Collagen is degraded by enzymes such as collagenase and serine proteases [49]. Wound dressing, artificial skin and vascular grafts are the popular applications of collagen. Some limitations of collagen scaffolds include high degradation rate, cell-mediated contraction [50, 51] and poor mechanical properties of collagen gels [52, 53].
2.4.3.1. Methods for Scaffold Preparation

A porous scaffold allows cells to migrate, proliferate, and vascularize. Porosity is a physical property independent of the scaffold material. It indicates the percentage of void space in scaffold. Higher porosity is required for tissue engineering applications such as bone. High interconnectivities between pores are desired for uniform cell seeding, cell distribution and diffusion of nutrients to and metabolites into and out of the cell/scaffold.

Several conventional techniques to create a continuous, uninterrupted pore structured scaffold are discussed.

**Fiber Bonding**

One of the earliest constructs to produce highly porous scaffolds was proposed by Freed and Mikos et al. [54]. Poly glycolic acid (PGA) fibers bonded in three-dimension provided large surface area for cell interaction and growth. The fibers are bonded by two different techniques. First technique involves immersing PGA fibers in poly L-lactic acid (PLLA) solution [55]. The solvent evaporates to form a network of PGA fibers in PLLA. The fiber is heated above the
melting point of both polymers. Spatial arrangement of fibers is retained as molten PLLA fills the voids. In order to minimize interfacial energy, fibers at the cross-points became welded together, forming highly porous foam. The PLLA is removed by dissolving in methylene chloride. This fabrication technique resulted in foams with porosities as high as 81% and pore diameters of up to 500 µm. Hepatocytes cultured for one week in these foams formed clusters [56]. In second method, PLLA dissolved in chloroform is sprayed on PGA fibers [57]. The fiber remained intact as PGA is weakly soluble in chloroform. The fibers are bonded with PLLA as chloroform evaporates.

**Drawbacks**

a) The solvents used can be toxic to cells if not completely removed.

b) The scaffolds are lyophilized for several hours to remove the solvents completely. This makes it difficult for immediate use in clinical practice.

**Solvent-Casting Particulate Leaching**

This technique involves producing uniform salt suspension with particles of a specific diameter in PLLA-chloroform solution [56, 58]. The evaporated solvent leaves behind a polymer matrix with salt particles embedded throughout. The composite is immersed in water. A porous structure is produced as the salt leaches from the composite. A lamination technique using chloroform as the binder was proposed to shape these scaffolds into 3D structures [59].

**Drawbacks**

a) The scaffold has limited interconnectivity and thickness

b) The salt is not completely leached from the composite

c) Poor control over internal architecture
Gas Foaming

A new technique to replace organic solvents with soluble inert gas such as CO$_2$ or N$_2$ in supercritical phase, was introduced by Monney et al [60]. Foam is created by a saturated biodegradable polymer, such as PLGA in CO$_2$ at high pressures. The solubility of the gas in the polymer is rapidly decreased as CO$_2$ pressure is reduced to atmospheric level. This results in nucleation and growth of gas bubbles. Porosity up to 93% and pore sizes ranging between 100-500 µm in the polymer is achieved by this method.

Drawback

Inevitable formation of skin layer and disjoint pores.

Phase Separation/Emulsification

Emulsion occurs between two phases, a continuous and dispersed phase. Usually the continuous phase is rich in polymer, while dispersed phase is water. In emulsion freeze-drying, water is rapidly cooled, and polymer is solidified to form a porous polymer structure. The emulsion freeze-drying creates large pores in thick scaffolds. Whang et al. dissolved PLGA in methylene chloride and distilled water to form an emulsion [61]. The solution is casted in a mold and is rapidly cooled by immersing in liquid nitrogen. Freeze-drying at -55°C removed the dispersed water and solvents. The scaffold has high porosity (nearly 95%) with small pores (13-33 µm).

Drawbacks

The use of toxic organic solvents coupled with small pore size inhibits cell growth.

Freeze Drying

Freeze drying or lyophilization is primarily used for fabrication of natural polymers such as collagen [62]. The polymer solution is frozen to form crystals. By sublimation, water crystals are directly converted to vapors. This method does not require toxic solvents to produce porous
interconnected structure. The pore size is altered by controlling the initial freezing temperature, pH and freezing rate [63].

**Drawbacks**

The main disadvantage is the difficulty to control pore size distribution, pore geometry and thickness of scaffold. The pores are not fully inter-connected due to the formation of skin layers during solvent evaporation.

**Electrospinning**

Electrospinning is widely used for the fabrication of nano fiber. Electric field of high voltage (10-20 kV) is combined with pressure to draw the polymer solution through the nozzle [64]. The surface tension of the polymer droplet is less than the electric field. The sprayed polymer is evaporated to form nano fibers. This simple and efficient process results in 2D mesh structure. 2D mesh with a pore size in nano scale is not sufficient for cell growth.

**2.5. Cells**

Cells are the basic building blocks of living organisms. The function of cells seeded in the scaffold strongly depends on specific cell-surface receptor used by the cells to interact with the surrounding cells [8] and materials. Fibroblast cells are mesenchymal cells and represent heterogeneous group of cells in terms of functional roles in different tissues. Fibroblast cells are principal cells of connective tissue. The cells are large, flat, elongated with flat and oval nucleus. Fibroblast cells produce tropocollagen, a forerunner of collagen filling the spaces between cells and fibers in connective tissue. Fibroblast cells also play a major role in wound healing by migrating to the site of damage and deposit collagen. Pulmonary fibroblast cells contribute directly to pulmonary inflammation and ultimately to airway remodeling. Fibroblasts are involved in deposition and remodeling of ECM within the lungs. Fibroblasts stimulate alveolar type II epithelial cell differentiation and proliferation during lung development [65].
2.6. Existing Models for Lung Constructs

Understanding the mechanisms of injury and repair is critical to develop new therapies. *In vitro* models have increasing demand as it captures the relevant *in vivo* tissue complexity where the monolayer culture fails to achieve. Monolayer cell cultures are influenced by the perturbations of external environment [13]. Individual cells respond by spatio-temporal cues in local or extracellular matrix. A three-dimensional cell culture produces signals from neighboring and distant cells. The signals allow *in vitro* models with engineered tissues to investigate the fundamental pathways of physiology and disease. However, constructing such models require understanding of the structure-function relation in tissues.

A variety of *in vitro* tissue engineering models are developed to capture the native lung environment. Current advances to produce *in vitro* models with complex *in vivo* characteristics use natural biomaterials for matrix or bioreactors [13].

Cortiella et al. investigated the inflammatory response of alveoli cells when grown on synthetic poly glycolic acid and pluronic F127 (PF-127) [66]. Poly glycolic acid is used for culture specific *in vitro* precursor cell types such as adult somatic lung progenitor cells. The study concluded that though poly glycolic acid has shown promising results in *in vitro* studies to engineer lung constructs, it induces inflammatory response in the host. This alters the lung tissue morphogenesis [67]. Patty Chen et al. conducted a study to grow alveolar-like structures *in vitro* within 2 mm thick collagen-glycosaminoglycan scaffolds [70]. The scaffolds fabricated by freeze drying method had a mean pore size of 95 µm. Chakir et al. studied the mechanisms pertaining to asthma by seeding bronchial fibroblast cells in collagen gel [68]. Some recent developments indicate growth of rat lung cells and formation of elastic units as *in vivo*, on collagen-glycosaminoglycan (GAG) [69]. EpiAirway™ made by MatTek (Ashland, MA) is a commercial...
*in vitro* lung construct used for drug delivery screening, toxicology, and respiratory infection studies.

Many *in vitro* diagnostic devices are developed for identifying respiratory allergens. Hitachi Chemical Diagnosis, Inc. (Mountain View, CA) developed The CLA® Allergen-Specific IgE Assay for measuring severity of patient’s allergic reaction. A sample with patient’s serum can be tested up to 36 different allergens.

Portable diagnostic devices such as I-STAT®, measures blood gases and enable to monitor the status of COPD patients. The devices allow informed decisions such as accurate dosing, alternations for medicine. One main benefit is cost reduction for patients with emergency admission.

*In vitro* models for screening toxic inhalants are being developed for the past decade. The next phase of research will require developing long term cell cultures. Long term cell cultures would enable investigation for chronic diseases such as acute bronchitis with repeat dosing and recovery studies.
CHAPTER III

MATERIALS AND METHODS

3.1 Fabrication of Collagen-Chitosan Porous Scaffolds

3.1.1. Materials
Chitosan chloride (75-90% de-acetylation, 150,000-400,000 g/mol) was purchased from FMC BioPolymer. PureCol collagen solution (type I, 3 mg/ml concentration) was purchased from Advanced BioMatrix (San Diego, CA). Hanging membrane inserts with a growth area of 0.3 cm² (pore size of 8 µm) and 6 well tissue culture plate with growth area of 9.6 cm² were purchased from Fisher Scientific (Franklin Lakes, NJ). RotoMix (type 50,800) purchased from Thermolyne was used for mixing the solution. All water used was type I ultrapure. Sodium tripolyphosphate (technical grade) and 2 ml graduated vials were purchased from Sigma Aldrich (St. Louis, MO).

3.1.2. Protocol
Homogenous collagen solution of 1 ml with a concentration of 1.5 mg/ml was prepared by mixing 600 µl of collagen and 400 µl water in 2 ml vial. Note: Collagen was completely mixed in
the bottle using 25 ml pipette before transferring to the vial. Care is taken to avoid forming any bubbles while mixing.

Chitosan-collagen solution of 1 ml was prepared by adding 30 mg of chitosan chloride to the collagen solution. The vial placed in the rotomix was maintained at 37°C until a homogenous solution was formed. Note: The contents in the vial may be mixed for overnight until a colorless, less viscous homogenous solution is formed.

The chitosan-collagen solution of 100 µl was transferred into hanging membrane inserts placed in well plates. Note: Care is taken to avoid formation of bubbles which leads to micro pores and might rupture the scaffold during formation. The samples placed in well plates were frozen at -20°C for two hours before lyophilizing for 10 hours. After first stage lyophilization, dried samples were chemically cross-linked by adding 500 µl of 10% sodium tripolyphosphate (TPP) at room temperature. Excess TPP was removed after two hours of crosslinking and replaced with 1 ml of water. The samples were set aside for an overnight period. Excess water was removed from samples and rinsed quickly three times. The samples were frozen at -20°C for two hours and lyophilized for 10 hours. Dry samples were stored at room temperature until further use.

3.1.3. Investigating the Effect of Varying Collagen and Chitosan Content on Scaffold Properties

A series of experiments were performed to test the effects of varying collagen and chitosan concentration on scaffold properties. The following criteria for the scaffold were selected from previous work and literature data:

a) Thickness less than 1000 µm [70].

b) Pore size greater than 50 µm for the cells to penetrate.

c) Porosity greater than 50% [71], [72].
Six samples were prepared as illustrated in Table 1 by varying collagen and water content, which resulted in varying collagen and chitosan concentrations. The samples were prepared by the protocol described previously.

Table 1. Experimental runs that varied the concentration of collagen and chitosan during scaffold preparation

<table>
<thead>
<tr>
<th>Sample Number</th>
<th>No. of parts Water</th>
<th>No. of parts Collagen (3 mg/ml)</th>
<th>Amount of Chitosan (mg)</th>
<th>Final Conc. of Collagen (mg/ml)</th>
<th>Final Conc. of Chitosan (mg/ml)</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>5</td>
<td>1</td>
<td>10</td>
<td>0.5</td>
<td>8.33</td>
</tr>
<tr>
<td>2</td>
<td>4</td>
<td>2</td>
<td>20</td>
<td>1</td>
<td>16.67</td>
</tr>
<tr>
<td>3</td>
<td>3</td>
<td>3</td>
<td>30</td>
<td>1.5</td>
<td>25.00</td>
</tr>
<tr>
<td>4</td>
<td>2</td>
<td>4</td>
<td>40</td>
<td>2</td>
<td>33.33</td>
</tr>
<tr>
<td>5</td>
<td>1</td>
<td>5</td>
<td>50</td>
<td>2.5</td>
<td>41.67</td>
</tr>
<tr>
<td>6</td>
<td>0</td>
<td>6</td>
<td>60</td>
<td>3</td>
<td>50.00</td>
</tr>
</tbody>
</table>

3.1.4. Scaffold Characterization

Tissue Engineered Medical Products Standards (TEMPS) is a standard developed by American Society for Testing and Materials International (ASTM) [73]. The scaffolds were characterized using ASTM guidelines i.e. F2603-06 and F2450-10.

The scaffolds were characterized by using scanning electron microscopy. The dried scaffolds were removed from insert wells by cutting to remove the bottom plastic film. Samples were mounted along the thickness on aluminum stubs. The stubs were coated in gold for 20 s using a sputter coater. The coated samples were analyzed with a scanning electron microscope (JOEL JSM 6360, Tokyo, Japan). The morphology and pore size were captured at 15 kV with 40 and 70 times magnification. The images were analyzed using ImageJ software and the pore size and porosity of the scaffold were determined, as described in Appendix A and B, relatively.
3.1.4.1. Porosity Measurement

The porosity of the scaffold was determined by examining a sectioned scaffold at 40X with a light microscope. The pore area was measured by using ImageJ (Appendix B), and the porosity was measured using the Eqn. 1 [74].

\[
\text{Porosity} = \frac{\text{Sum of pore area}}{\text{Area of the scaffold}} \times 100
\]  

(1)

3.1.4.2. Swelling Studies

Permeability of liquid is an important property of a scaffold as it affects the nutrient diffusion and transportation in the scaffold. To estimate the absorption rate of collagen-chitosan scaffold, initial weight of dry scaffold was noted. The scaffold placed in an insert well containing 500 µl of Medium 199 purchased from Invitrogen (Carlsbad, CA) with pH = 7.4 was maintained at 37°C. After 1 hour, the scaffold was removed from the well. Excess medium was removed by placing it on filter paper. The final weight of the scaffold was noted. The swelling capacity was calculated as in Eqn. (2).

\[
\text{Swelling Capacity} = \frac{\text{Final weight} - \text{Initial weight}}{\text{Initial weight}}
\]

(2)

3.2. Seeding Cells within the Porous Scaffold

3.2.1. Materials

Normal human dermal fibroblast cells and reagents for cell growth were purchased from PromoCell (Heidelberg, Germany). Nalge Nunc International T-75 culture flasks, dimethyl sulfoxide (DMSO), and paraformaldehyde (4% in PBS) solution were purchased from Fisher Scientific (Rochester, NY). Dulbecco’s phosphate-buffered saline (PBS), Medium 199 (10X
M199) and CellTracker red (CMPTX) were purchased from Invitrogen (Carlsbad, CA). Sodium hydroxide was purchased from VWR (West Chester, PA).

3.2.2. Cell Culture and Preparation

The surface area for cell culture was calculated according to plating density. Culture flasks coated with 4 ml of fibronectin was incubated for at least 2 hours at 37°C and 5% CO₂ atmosphere. Fibronectin was completely removed from the flask and 14 ml of medium was added. The flask was incubated for at least a half hour. A cryovial with fibroblast cells isolated from the dermis of adult skin was removed from liquid nitrogen storage and placed in a water bath at 37 °C to thaw. The contents in vial were mixed completely and dispensed into the prepared flask with medium. The flask was rocked gently to distribute the cells evenly. Care was taken not to splash the contents onto the top surface or air filter in the cap. The cells were grown at 37°C and 5% CO₂ atmosphere. Every 48 hours, medium was changed and cell growth was monitored under a light microscope. At 90% confluency, cells were prepared for use in the scaffolds.

Cells were fluorescently labeled, per the manufacturer’s instructions. Briefly, CellTracker red solution was prepared in 10 mM DMSO. Medium was removed from the cell culture flask. Pre warmed CellTracker dye working solution of 10 μm in culture medium was added to the flask. The flask was incubated at standard conditions for 30 min. The dye working solution was replaced with pre warmed medium and incubated at standard conditions for 30 min. Adherent cells were removed from the flask by trypsinization and used for cell seeding on the scaffolds.

Briefly, labeled cells were detached from the flasks by adding trypsin. The collected cells were centrifuged for 5 min at 1200 rpm and 4°C. The supernatant was removed and the cells were resuspended in 1 ml medium. The total number of cells was counted using a hemocytometer.
3.2.3. Collagen Gel Preparation

The collagen gel solution with 1 and 2 mg/ml was prepared. Briefly, collagen, 10X M199, 0.1 N NaOH and PBS were mixed in the same order to form a homogenous solution. The concentration of the reagents used is indicated in Table 2. The pH of the collagen solution was maintained at 8.46. Approximately 1.4 million cells /ml were mixed with the collagen solution to form a homogenous collagen-cell solution.

<table>
<thead>
<tr>
<th>Table 2. Collagen gel preparation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Collagen (vol. percent)</td>
</tr>
<tr>
<td>--------------------------</td>
</tr>
<tr>
<td>33.2</td>
</tr>
<tr>
<td>66.7</td>
</tr>
</tbody>
</table>

3.2.4. Seeding Cells within the Scaffold

Prior to cell seeding, dry scaffolds were sterilized by treating with ultra violet light in a biosafety cabinet for 45 min. A 1 ml collagen-cell solution was distributed evenly on the top of the dry scaffold with a micropipette. The scaffold was centrifuged for 20 min at 4°C and incubated at standard conditions (37°C and 5% CO₂ atmosphere) for 45 min, to gel and trap the cells within the matrix. After gelation of the collagen, 500 μl of medium was added to the scaffold. After 24 hours, the scaffolds were observed by light microscopy for cell attachment.

3.2.5. Experimental Design to Investigate the Effect of Collagen Concentration and Centrifugal Force on Cell Distribution within the Scaffold

To study the influence of the collagen concentration and centrifugal speed (force) on cell growth and cell distribution, a full factorial design was developed as shown in Figure 8. With input materials as cells and scaffold, the factor variables were assumed to be collagen concentration and centrifugal speed.
The following are the factors held constant for all samples.

1. Approximately 1.4 million cells/ml were seeded on the samples.
2. Samples were incubated for 45 min in 37°C at 5% CO₂ atmosphere for collagen to gel.
3. Temperature and time for centrifugation was maintained as 4°C and 20 min, respectively.

**Process Factors**

Figure 8. Schematic of the experimental design to study the effect of collagen concentration and centrifugal force on cell growth and distribution in the scaffold.

A two-factor with two-level factorial design was created as shown in Table 3. The interaction of collagen concentration and centrifugal speed were studied with six different runs with varying collagen concentration and centrifugal speed. The runs were compared to a static control with cells suspended in medium seeded on the top of the scaffold. Cells dispersed uniformly in medium, were added statically on the top of a scaffold. The scaffold was used as control to study the impact of centrifugal force and collagen concentration in cell distribution.
Table 3. A two-factor and two-level factorial design matrix to investigate the effect of collagen concentration and centrifugal force on cell growth and distribution within the scaffold

<table>
<thead>
<tr>
<th>Run</th>
<th>Factor A: Collagen Concentration</th>
<th>Factor B: Centrifugal Force</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Level 0 (0) 0 mg/ml</td>
<td>Level 1 (1) 1200 rpm (259 x g)</td>
</tr>
<tr>
<td></td>
<td>Level 1 (1) 1 mg/ml</td>
<td>Level 2 (2) 2200 rpm (840 x g)</td>
</tr>
<tr>
<td>No. 1</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>No. 2</td>
<td>0</td>
<td>1</td>
</tr>
<tr>
<td>No. 3</td>
<td>1</td>
<td>1</td>
</tr>
<tr>
<td>No. 4</td>
<td>2</td>
<td>1</td>
</tr>
<tr>
<td>No. 5</td>
<td>0</td>
<td>2</td>
</tr>
<tr>
<td>No. 6</td>
<td>1</td>
<td>2</td>
</tr>
<tr>
<td>No. 7</td>
<td>2</td>
<td>2</td>
</tr>
</tbody>
</table>

3.2.6. Cell Seeding Efficiency and Viability within the Scaffold

Cell seeding efficiency and viability in the sample were estimated 24 and 72 hours after seeding, respectively. Spectrofluorometer (SpectraMAX GeminiXS, Molecular Devices, Sunnyvale, CA) measures the fluorescence units emitted by CellTracker red when excited. The emission and excitation wavelength of CellTracker red is 590 and 610 nm, respectively.

CellTracker red is a fluorescent probe that is retained in living cells through several generations inherited by daughter cells. The probes are not transferred to adjacent cell populations. Cells are loaded with probes by adding reagent to culture media and washed briefly with fresh media before analysis. The reagents pass through cell membranes and convert into cell impermeant reaction products with thiol groups. The reaction products, a thioether adduct, can be fixed with aldehyde fixatives for long term storage. The probes do not require enzymatic cleavage to activate the fluorescence. The reaction products have excellent retention and strong fluorescence with relatively uniform cytoplasmic staining. CellTracker red reagent allows cellular retention for long term studies of normal and transformed cells in culture, thiol levels, cell viability,
cytotoxicity and cell fusion [75]. CellTracker red can be counter stained with DAPI (4', 6-
diamidino-2-phenylindole).

DAPI is a counterstain with a distinct blue fluorescence. DAPI stains the nuclei acid with little or
no cytoplasmic labeling. The stain binds to the deoxyribonucleic acid (DNA) in a cell, enhancing
the fluorescence by 20 fold. The selectivity for DNA and high cell permeability allows effective
staining of nuclei in living or fixed cells.

The viability for different runs listed in Table 3 was calculated as relative fluorescence units. Cell
viability of a sample was measured as fluorescence units emitted by the cells 24 and 72 hours
after seeding.

Standards

Two standard designs were used to evaluate the experimental design.

a. Two-dimensional monolayer cell culture

b. Three-dimensional collagen gel

Two-dimensional cell culture is used to compare cell growth on a two-dimensional surface to a
three-dimensional porous scaffold. Approximately 75,000 cells/cm² suspended in medium were
added to a hanging insert. The cells were monitored for seeding efficiency (24 hours) and
viability (72 hours).

Three-dimensional collagen gel was prepared with two collagen concentrations viz., 1 and 2
mg/ml. Cells mixed in collagen gel solution were incubated at standard conditions for 45 min to
form a three-dimensional gel and monitored for cell growth. Collagen gel was used as a standard
to compare cell growth within a proven cell friendly three dimensional system to a three dimensional porous scaffold.

Cells uniformly dispersed in medium were statically added to the top of a scaffold. The scaffold was used as control to study the impact of centrifugal force and collagen concentration on cell distribution.

3.2.7. Cell Spatial Distribution within the Scaffold

Cell attachment, proliferation and spatial distribution (XY plane and Z direction) were measured by fixing the cells with 4% formaldehyde to the samples 24 and 72 hours after seeding. The samples were sectioned along the thickness as top, middle and bottom using a microtome (Figure 9). The sectioned samples were counter stained with DAPI and cover slipped. DAPI stains the nuclei acid of fixed cells, while CellTracker red stains the cytoplasm of live cells. To quantify cell distribution in the scaffold, images were captured at 200X with a fluorescent microscope. A fluorescent microscope illuminates light of a specific wavelength absorbed by fluorophores. Fluorophores emit light of longer wavelength when excited. DAPI and CellTracker red emit blue and red color when excited with UV and green optical filters, respectively. Each section was divided into five parts viz., A, B, C, and D, representing four corners of the circle, and O as the center. Acquired images were analyzed using ImageJ software.
Figure 9. Scaffold sectioned for measuring cell distribution.
CHAPTER IV

RESULTS AND DISCUSSION

4.1 Fabrication of Collagen-Chitosan Porous Scaffolds

4.1.1. Scaffold Optimization

Several factors such as viscosity, concentration of chitosan, and temperature of the solution influence scaffold preparation. Pogodina et al. studied the effect of temperature on intrinsic viscosity of chitosan solution [76]. The study concluded that intrinsic viscosity of chitosan decreased with increasing temperature. Filar and Wirick et al. reported the same trend for apparent viscosity of chitosan between 25 and 60°C [77]. The same behavior was also noticed in water soluble chitosan solutions [78]. The influence of temperature on apparent viscosity is determined by the Arrhenius equation. The flow activation energy, $E_a$ of water soluble chitosan solutions decreases with increasing reaction temperature. The flow properties of chitosan solutions are affected by competition for water at high concentrations of chitosan [79]. To decrease the viscosity of the collagen-chitosan solution, the diluted solution was maintained at a constant temperature of 37°C.
Desbrieres et al. noticed that chitosan exhibits Newtonian behavior at lower concentrations and Non-Newtonian at concentrations greater than 15 g/L (Figure 10) [80]. This similar behavior also holds for a temperature range of 279-328 K and up to 50 g/L.

![Figure 10. Effect of viscosity on chitosan concentration at 278 K.](image)

Table 1 shows the composition of six samples prepared with varying collagen and chitosan concentrations. During experimentation, viscosity of the solution was noticed based on ease of solution transfer using a standard pipette. The viscosity increased with an increase in the chitosan concentration greater than 25 mg/ml as in Sample 3. An undiluted sample has a collagen concentration of 3 mg/ml and 50 mg/ml of chitosan. Two samples per group were characterized for pore size, thickness and ease of reproducibility. The samples were characterized using SEM images, as shown in Figure 11.
Figure 11. Scanning electron microscope images of six samples revealing the surface morphology \((n = 2)\). (a), (b) represents Sample 1. (c), (d) represents Sample 2. (e), (f) represents Sample 3. (g), (h) represents Sample 4. (i), (j) represents Sample 5. (k), (l) represents Sample 6.

SEM images of Sample 5 (Figure 11, i and j) show the surface of the scaffold with very few pores. This sample was not characterized for pore size.

The thickness of the samples varied from 360 to 1200 µm with the varying concentrations of collagen and chitosan (Figure 12). The volume of polymer solution per insert well was maintained at 100 µl. Samples with collagen concentration of less than 2 mg/ml i.e. Sample 1 through 3 were brittle and were prone to physical damage even with gentle handling.
Figure 12. Influence of chitosan concentration on thickness of samples. Mean thickness of scaffold is represented by bar graph with chitosan concentration in small triangles (n=2).

Figure 13 shows the average pore size of samples. The pores were elliptical in shape and the best fitting ellipse was used to measure the major and minor pore size of the samples. Sample 1 had the maximum pore size of 132 µm (±18), while Sample 6 had the minimum of 80 µm (±18). Sample 6 with collagen concentration of 3 mg/ml had a thickness of 900 µm with a mean major pore size of 72 µm (±18). With a decrease of collagen concentration, the mean pore size increased. Sample 4 had a mean major pore size of 98 µm (±19) and was 800 µm thick. This sample was chosen due to it met the set criteria and was durable during handling. The aspect ratio and roundness of the sample was calculated to be 1.23 and 0.83, respectively.
4.1.2. Porosity Measurement

The sectioned scaffold (Figure 14) was used to measure the porosity of the scaffold. The porosity was measured to be 70.3% (±4.3).

Figure 13. Mean pore size of samples with Sample 1 as maximum (n=2).

Figure 14. Images of a sectioned scaffold using a light microscope.
4.1.3. Pore Size Distribution

Three sections were cut from samples embedded in paraffin and each section was analyzed for the pore size distribution. Images were captured using a fluorescent microscope at 40X magnification. Figure 14 shows an image when viewed using either the UV or Green filter with high exposure setting, to reveal the best image of the pores. For the calibrated area (µm²), approximately 100 pores /section was measured using ImageJ software.

Figure 15 shows a box plot with the distribution of pores across three sections. The pores of all the sections were consistent with low variability. The mean pore area was around 1000 µm². The pores in the top section were skewed to the right with a wide range of outliers. This could be due to chemical treatment required for the microtome sectioning.

![Box plot showing pore size distribution](image)

Figure 15. Box plot shows distribution of pores within three sections, Bottom, Middle and Top, of the scaffold.

4.1.4. Swelling Behavior

Most hydrogels, such as collagen and chitosan, swell readily in biological fluids. During swelling, the increase in pore size facilitates the cells to attach and penetrate into the scaffold [81].
Maximum internal surface area of the scaffold is available for the cells.

The maximum swelling capacity of the scaffold was 15.91 (±1.1) times the dry weight. The equilibrium was attained in one hour. Medium M199 was selected as the buffer to simulate the swelling behavior during *in vitro* cell culture studies.

### 4.2. Seeding Cells within the Porous Scaffold

#### 4.2.1. Cell Seeding Efficiency

Figure 16 shows the morphology of a monolayer and a three-dimensional collagen gel 72 hours after seeding, captured using a fluorescence microscope at 200X magnification. In a monolayer of cells grown on a flat plate, the orientation of the cells is restricted to the XY plane. In a three-dimensional collagen gel, the vertical Z axis is added to the monolayer of cells, due to collagen thickness. Thus, a three-dimensional spatial orientation is achieved.

![Cell morphology](image)

Figure 16. Cell morphology shows spatial orientation in a (a) 2D monolayer and (b) 3D collagen gel.

After sectioning, stained scaffolds were analyzed by fluorescent microscopy at 200X magnification. By observing the cells and distribution using microscopy after 24 hours of cell seeding, the spatial density of attached cells was determined. Figure 17 shows a section of the
scaffold with cell nuclei and cytoplasm stained in blue and red, respectively. The cell densities in the images depend on the available surface area for cell adhesion. The standard surface area for each location when viewed under the microscope was $0.017 \text{ mm}^2$. As a result of well-defined, interconnected pore structure, the local values of specific surface area showed only minimum variation. Therefore it is possible to compare cell population across thickness.

Figure 17. Images captured 24 hours after cell seeding, showing that cells are attached on the pore walls of the scaffold (a) DAPI stained cells; (b) CellTracker red stained live cells; (c) Image of scaffold under white light with highlighted pore (d) Merged image of (a), (b) and (c).

The spectrofluorometer reading is a measure of CellTracker red present in the cytosol of live fibroblast cells. The probe inside the cells emits at 610 nm wavelength when excited at 590 nm wavelength. The qualitative measure of the cell viability in a sample is recorded by the spectrofluorometer.
Figure 18 shows fluorescent intensity readings from attached cells after background reduction. Three-dimensional samples recorded higher cell viability compared to the two-dimensional monolayer of cells. The cell viability of the static control was nearly equal to the three-dimensional collagen gel standard (2 mg/ml). This indicates that the scaffold offers low toxicity to cells.

Cells seeded in a collagen solution have higher cell viability as observed in the collagen gel standard and scaffold samples. Initial cell attachment in Group 3 with a centrifugal speed of 1200 rpm and collagen concentration of 2 mg/ml recorded maximum intensity among all scaffold samples. Increase in centrifugal speed to 2200 rpm, reduced initial cell attachment observed in Groups 4 through 6. This reduction could possibly be due to high stress applied on the cells during centrifugation at the higher speed. Cell viability continued to increase in collagen samples after 72 hours. Groups 2 and 3 with a collagen concentration of 1 mg/ml showed a higher intensity, when compared to Groups 5 and 6 with 2 mg/ml, respectively.

Spectrofluorometer have an advantage of consistent measurement with no lag time between samples. It also captures the intensity through thickness of the collagen gel. However, the reading represents only the bulk of the sample. To study the intensity between different layers, images of sectioned samples captured using a fluorescence microscope was analyzed with ImageJ software.
Figure 18. Spectrofluorometer reading on a) Cell seeding and (b) Cell viability shows high intensity when seeded with collagen solution of 2 mg/ml (n = 3). 3D collagen gel with 1 and 2 mg/ml is denoted as collagen 1 and 2, respectively. 2D Sample indicates monolayer cell culture while control denotes statically seeded scaffold. For group definitions refer Figure 20.
4.2.2. Cell Growth and Distribution

Spatial distribution of cells after seeding impacts the growth of engineered tissue constructs. An inefficient seeding technique will limit the ability of the tissue construct to mimic in vivo conditions. Various types of cell seeding techniques have been investigated. In this study, the effect of two main variables, collagen concentration and centrifugal speed on cell spatial distribution and efficiency were investigated. The results of this study indicated significant differences in cell distribution in the interior of the scaffolds.

For the negative control sample (Control), no collagen solution or centrifugation was used for cell seeding. A homogenous cell suspension in media was statically seeded on the top of the scaffold and was observed after 24 and 72 hours. The control sample negates the force due to viscosity of the collagen solution and centrifugation on cell growth and distribution. Shown in Figure 19 is the reference for various seeding techniques. The x and y coordinates can be read as collagen concentration and centrifuge speed, respectively.

![Figure 19. Reference for various experimental conditions used during cell seeding.](image-url)
4.2.2.1. Cell Distribution along the Z Direction

The influence of varying collagen concentration and centrifugal speed on cell distribution along the scaffold thickness (Z direction) was studied with a control sample. The goal of this analysis was to obtain a uniform distribution of cells in the Top, Middle and Bottom sections of the scaffold.

![Cell Distribution Graph](image)

Figure 20. Cell distribution in Z direction shows that Group 5 has best cell distribution 24 hours after seeding. For group definitions refer Figure 20.

In the statically seeded control sample, the majority of cells were attached on the top surface of the scaffold (Figure 20). Cell penetration into the scaffold was low 24 hours after seeding. Addition of centrifugation (at 1200 or 2200 rpm), forced the majority of cells to settle at the bottom of the scaffold, as observed in Groups 1 and 4.

Cells suspended in a collagen solution were added to the top of scaffolds in Groups 2, 3, 5 and 6. Group 2 with a collagen concentration of 1 mg/ml and centrifuged at 1200 rpm showed a descending, linear cell distribution with a majority of the cells on the top surface. The cell
distribution of these samples could be due to the viscous nature of collagen, which prevents the cells from settling to the bottom. Increasing in the centrifuge speed to 2200 rpm, increased the distribution of cells to the bottom of the sample for Group 5. Compared to Group 2, a minimum of cells were retained on the top section. Group 6 retained a majority of cells at the top and a minimum in the middle. This is attributed to the increase in collagen concentration to 2 mg/ml when centrifuged at 2200 rpm. The best distribution of cells was achieved with a balance of viscous and centrifugal force, as noticed in Group 5.

Figure 21 shows cell proliferation and distribution after 72 hours. It was observed that an aggregation of cells found on the top of the Control and Group 5 scaffolds, contributed to cell growth. Using centrifugal force to seed cells without the collagen solution, as in Groups 1 and 4, reduced the percentage of viable cells at the bottom section.
4.2.2.2. Cell Distribution along the XY Plane

The samples in the well plate were centrifuged for 20 min. An equal balance of centrifugal and viscous force provides an ideal distribution of cells. Figure 22 shows the cell distribution in the XY plane for initial cell attachment and cell viability. An ideal cell distribution along the XY plane would have a blue color code throughout the sample. Red color code indicates a dense formation of cells, while blue indicates sparsely distributed cells.

The only sample that best represents the ideal distribution was Group 6 with a collagen concentration of 2 mg/ml and centrifuged at 2200 rpm. The middle and bottom sections were better spread when compared to the top. An important finding of this study was the decreasing effect of centrifugal force along the thickness of the sample was observed in Group 3 with a centrifugal speed of 1200 rpm. Compared to Group 6, cell aggregates in Group 3 tend to attach to the circumference of the middle and top sections. Group 5 has the best distribution of cells in the Z direction. However, the majority of cells were clustered in the center in XY plane. Cells suspended in medium and centrifuged at 1200 or 2200 rpm (Group 1 or 4), quickly attached along the peripheral of the bottom section.

Increase in the viscosity of the collagen solution offers a better resistance from quick settling at the bottom, as well as along the circumference of the sample. A combined effect of viscous and centrifugal force, provides a good distribution with less aggregation along the XY plane, as seen in Group 6

Figure 22 b shows cell aggregation increased proliferation and provided better spread along the plane 72 hours after seeding.
<table>
<thead>
<tr>
<th>(a)</th>
<th>Top section</th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Control</td>
<td>Group 1</td>
<td>Group 2</td>
<td>Group 3</td>
<td>Group 4</td>
<td>Group 5</td>
<td>Group 6</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

| (b)          | Top section |  |  |  |  |  |  |  |  |
|--------------|-------------|---|---|---|---|---|---|---|
| Control      | Group 1     | Group 2 | Group 3 | Group 4 | Group 5 | Group 6 |

Legend:
- 0-8%
- 9-18%
- 19-24%
- 25-34%
- 35-44%
- >44%
4.2.3. Cell Viability and Proliferation

Cytosol in cells was labeled with CellTracker red prior to seeding. Viable cells emit fluorescence when exposed with green emission under a fluorescence microscope. The corrected background fluorescent intensity was calculated using ImageJ software. Viable cells with red cytoplasm were also verified with DAPI stained nuclei. The fluorescence emitted by the cells was measured by reducing the background intensity and is reported as the corrected mean fluorescent intensity. Measurements for background intensity were obtained from the same sample image.

Figure 23 shows the percent of corrected mean fluorescent intensity of viable cells in three sections of the scaffold. Group 3 and the control sample have uniform intensity across all three sections of the scaffold. Uniform intensity across the three sections indicates that approximately the same number of cells is attached in each section. An increase in collagen concentration resulted in an increase in fluorescent intensity as in Groups 3 and 6. The viability of cells seeded with a collagen concentration of 2 mg/ml was greater than all other samples. The results are verified with the spectrofluorometer readings, which measures the bulk fluorescence of a sample. Equivalent cell viability was achieved in the middle section of Group 5.

Cell viability is measured as the total number of viable cells present in five locations across three sections of a sample. Though a majority of cells attached to the control sample in 24 hours, the percentage of cell proliferation drastically reduced to 23%. This could be due to the saturation of cell attachment sites, thereby reducing the efficiency. Very few cells were present in the middle and bottom of the scaffold. It was observed that static seeding has low cell penetration, when compared to dynamic seeding. Initial cell distribution throughout the scaffold increases cell attachment to the pore walls. This can be achieved by dynamic seeding techniques.
The data in Figure 24 shows cells when mixed in collagen solution, readily attached to the scaffold. The viability of cells mixed in collagen solution and centrifuged at 1200 rpm as in Group 2, increased by 132%. This increase was mainly observed in the middle section after 72 hours. The viscous nature of collagen can act as a barrier for cells by encapsulating cells inside the gel. The stress applied to the cells is reduced and cell growth is promoted. However, an increase in centrifuge speed to 2200 rpm as in Group 5, increased cell growth to only 36%. Group 3 exhibited an increase of 84% with a collagen concentration of 2 mg/ml when centrifuged at 1200 rpm. About five times the cell growth was achieved at the bottom section 72 hours after seeding. To conclude, the use of a dynamic force such as centrifugation has increased cell viability with an optimum speed of 1200 rpm and collagen concentration of 1 mg/ml. A speed above this range has been shown to reduce cell proliferation. Low cell proliferation was measured when centrifuged without collagen solution, as in Groups 1 and 4.
Figure 24. Total number of viable cells in three sections of the scaffold shows that collagen has increased cell proliferation 72 hour after seeding. For group definitions refer Figure 20.

In 72 hours, the intensity of Groups 6 and 4 has appreciably decreased across all the sections of the sample. A decrease in intensity could be due to a decrease in cell growth of 13%. Cell viability in Group 3 did not significantly change after 72 hours. The net cell growth might be nearly equal to cell death. Intensity on the top section of the control indicates cell growth, while other sections had cell death or less cell growth. The intensity of Group 1 decreased appreciably, due to an increase in cell growth by 8%. Though the percent of cell growth was a maximum for Group 2, the overall increase in intensity was small with a majority due to the top section. Group 5 observed a 36% increase in cell growth with the majority in the middle section. The quantitative results for cell growth were obtained by measuring fluorescence intensity across three sections of the sample.
4.3. Characterizing Seeding Conditions

Dynamic conditions can be optimized to maximize cell distribution and growth. The static seeding method appears to have cell loading limitations with a majority of cell aggregates on the surface of the scaffold. An increase in centrifugation can accelerate mechanical degradation of the scaffold with a shear force that adversely affects cell growth and attachment. Thus dynamic seeding must be carefully controlled with centrifugal speed and collagen concentration.

Scaffold seeding conditions can be optimized based on the following three responses: cell distribution in the Z direction, cell distribution in the XY plane, and the percent increase in cell growth after 72 hours. Table 4 displays the ranking of scaffold groups based on the responses. Each group was ranked between 1 and 6 with 1 as best and 6 as worst. Groups 1 and 4 were not included since cells were seeded in medium.

<table>
<thead>
<tr>
<th>Sample</th>
<th>Collagen Conc. (mg/ml)</th>
<th>Centrifuge Speed (rpm)</th>
<th>Cell Distribution Z direction (24 hours)</th>
<th>Cell Distribution XY plane (24 hours)</th>
<th>% of Cell Growth after 72 hours</th>
<th>Total Score</th>
</tr>
</thead>
<tbody>
<tr>
<td>Group 1</td>
<td>0</td>
<td>1200</td>
<td>6</td>
<td>3</td>
<td>4</td>
<td>13</td>
</tr>
<tr>
<td>Group 2</td>
<td>1</td>
<td>1200</td>
<td>3</td>
<td>5</td>
<td>1</td>
<td>9</td>
</tr>
<tr>
<td>Group 3</td>
<td>2</td>
<td>1200</td>
<td>4</td>
<td>1</td>
<td>2</td>
<td>7</td>
</tr>
<tr>
<td>Group 4</td>
<td>0</td>
<td>2200</td>
<td>5</td>
<td>4</td>
<td>5 (tie)</td>
<td>14</td>
</tr>
<tr>
<td>Group 5</td>
<td>1</td>
<td>2200</td>
<td>1</td>
<td>6</td>
<td>3</td>
<td>10</td>
</tr>
<tr>
<td>Group 6</td>
<td>2</td>
<td>2200</td>
<td>2</td>
<td>2</td>
<td>5 (tie)</td>
<td>9</td>
</tr>
</tbody>
</table>

Cell aggregation is a function of centrifugal force along the XY plane. Increased cell aggregation was observed when samples were centrifuged at 2200 rpm. The analysis of the spatial distribution along the XY plane indicated that cluster formation was common for dynamic seeding. The equilibrium of viscous and centrifugal forces in axial and radial directions improves the seeding efficiency and spatial distribution of cells within the scaffolds.
Group 3 has the lowest total score. The group showed good cell distribution in the XY plane and 84% cell proliferation. However, the majority of cells were retained on the top surface. Since a major objective of this project was to seed cells within the scaffold in the Z direction, this group is not recommended as the optimum cell seeding condition.

Groups 2 and 6 have the next lowest scores. Group 2 showed good cell distribution in the Z direction and a 132% increase in cell proliferation after 72 hours. Due to a wide distribution of cells in the XY plane for this group, it is not recommended as the optimum cell seeding condition. Group 6 showed good overall cell distribution in both the Z direction and the XY plane. Unfortunately, this group showed the lowest increase in cell proliferation after 72 hours, indicating possible cell death. Thus, the method for Group 6 was not recommended for optimum seeding conditions.

The goal of this study was to characterize the effect of a new cell seeding technique on cell viability, proliferation, and distribution within a scaffold. Based on the parameters tested, dynamic seeding at 2200 rpm with a collagen concentration of 1 mg/ml, Group 5, is the optimum seeding method in this study with 36% increase in cell growth after 72 hours of seeding. The method provides a good distribution of cells in the Z direction and cell proliferation after 72 hours of seeding. Even though the cells were not distributed along the XY direction as well as some of the other groups, the distribution of cells along the thickness provides more area for the cells to grow and migrate.
In *vitro* tests are often used prior to or in place of *in vivo* and subsequent clinical studies. *In vitro* tests are designed to generate data that provides a general insight into disease mechanisms and the biological effect of test compounds and materials. Human cells and tissues are used to maintain as many physiological parameters in *in vitro* systems. Modeling *in vitro* systems for an organ includes the use of established continuous cell lines, primary cells and tissues. Primary cell cultures explanted from a healthy or diseases donor are differentiated with a limited life span.

Many lung diseases, such as COPD, are multifaceted diseases and one ideal *in vitro* model would not be sufficient to replicate the pathogenesis. An *in vitro* lung model of COPD must, therefore utilize different cell types involved in disease pathogenesis. As first steps in developing a pulmonary *in vitro* model, a suitable scaffold must be fabricated and a cell seeding technique that results in cells distributed evenly throughout the scaffold must be used. In this study, a thin and porous chitosan-collagen scaffold was fabricated within the specs required for a pulmonary *in vitro* model. Chitosan and collagen were chosen as scaffold materials to provide structural
support with biochemical cues offered by extracellular matrix. Scaffolds were fabricated by a two-stage freeze drying method. An optimum scaffold composition was selected based on a thickness less than 1000 µm, a mean pore size greater than 50 µm, and a porosity greater than 50%. The criteria represent the blood gas barrier in lungs. Chitosan and collagen concentrations of 33 and 2 mg/ml, respectively, were used to fabricate the scaffold. The mean major pore size and thickness of the scaffold was measured as 130 and 800 µm, respectively.

Fibroblast cells mixed in collagen solution seeded on top of the scaffold were centrifuged for 20 min. An optimum seeding technique for uniform cell distribution throughout the scaffold was selected based on cell attachment after 24 hours and cell viability after 72 hours. Cell growth and distribution was observed using a fluorescence microscope. The influence of collagen concentration and centrifugal force on spatial cell distribution along Z direction and XY plane was studied. Collagen solution increases cell viability and retains a majority of cells on the top surface. Centrifugation increases cell penetration into the scaffold but reduces cell proliferation and viability. Cells accumulate at the bottom after centrifugation at higher centrifugal speeds. Cells seeded in a collagen solution of 1 mg/ml and centrifuged at 1200 rpm had a high cell viability of 132% 72 hours after seeding, when compared to initial cell attachment. The cells were widely distributed in the XY plane.

After careful investigation, a balance of the viscous nature of the collagen solution and the centrifugal force led to a uniform distribution of cells throughout the matrix. An optimum seeding method with a collagen solution of 1 mg/ml and a centrifugal force of 840 x g (2200 rpm) provided a uniform distribution of cells in the Z direction. An increase in collagen concentration to 2 mg/ml resulted in an ideal cell distribution in the XY plane, but with an increase in cell death.
Though the findings of this study are specific to fibroblast cells in a collagen-chitosan scaffold, the cell seeding technique can be adopted for use with other applications. The results presented here illustrate a methodology for spatial distribution of cells within scaffolds. This contributes to the framework for generating predictable and controlled tissue engineering constructs. Such constructs have the potential to advance in the field of tissue engineering with wide clinical applications.
This project can be applied to developing a 3D \textit{in vitro} system that simulates the blood-gas barrier in lungs. The project can be classified as Phase I, developing uniform fibroblast cell distribution within the scaffold. Phase II would involve studying the epithelial cell growth on the surface of the scaffold, which depicts the alveolar layer of cells grown on the blood gas barrier. Phase III would be a combination of I and II with the endothelial cells grown on the opposite surface of the scaffold. The study of immune cell trafficking and interaction with other cells within the system would be conducted in Phase IV. With the completion of Phase IV, a complete \textit{in vitro} system is developed and can be used to study inflammation in response to lung infections.
REFERENCES

39. Moroni, L., et al., *Fiber diameter and texture of electrospun PEOT/PBT scaffolds*


Appendix A: Pore Size Analysis

ImageJ is a free distribution software used for analyzing and processing images. JAVA based software is developed at the National Institutes of Health (NIH) [82]. The pore size is analyzed using an SEM-SEI (Secondary Electron Imaging) image magnified 70 times with a scale of 200 µm (Figure A1).

Figure A1. Analysis of pore size using ImageJ software.
The following are the steps performed.

1. Open ImageJ, version 1.44.

2. Browse for the image from ‘File’ -> 'Open' option

3. Use the ‘Straight’ line from the menu; draw the line on the scale bar.

4. Measure using ‘Analyze’ -> 'Measure' option

5. Update ‘Analyze’ -> ‘Set Scale’ -> ‘Unit of length’ as µm and ‘Known distance’ as 200

6. Use ‘Elliptical’ from the menu to draw the best fit circle on the pores

7. Add to the ROI Manager under Analyze -> Tools

8. Check Edit Mode to display the number on each circle of the pores

9. ROI -> Measure, to measure the pore area in µm².

<table>
<thead>
<tr>
<th>Results</th>
<th>File</th>
<th>Edit</th>
<th>Font</th>
<th>Results</th>
</tr>
</thead>
<tbody>
<tr>
<td>Area</td>
<td>Mean</td>
<td>Major</td>
<td>Minor</td>
<td>Angle</td>
</tr>
<tr>
<td>1</td>
<td>1061.224</td>
<td>65.508</td>
<td>46.114</td>
<td>29.301</td>
</tr>
<tr>
<td>2</td>
<td>13028.571</td>
<td>89.244</td>
<td>166.818</td>
<td>99.441</td>
</tr>
<tr>
<td>3</td>
<td>2681.653</td>
<td>40.459</td>
<td>69.429</td>
<td>52.846</td>
</tr>
<tr>
<td>4</td>
<td>122688.163</td>
<td>83.813</td>
<td>601.203</td>
<td>260.086</td>
</tr>
<tr>
<td>5</td>
<td>41322.449</td>
<td>93.457</td>
<td>254.228</td>
<td>224.825</td>
</tr>
<tr>
<td>6</td>
<td>26616.827</td>
<td>100.864</td>
<td>176.415</td>
<td>170.448</td>
</tr>
<tr>
<td>7</td>
<td>36375.519</td>
<td>92.773</td>
<td>219.693</td>
<td>210.015</td>
</tr>
</tbody>
</table>

Figure A2. Result window of ImageJ.

The results window display one or more of the following (Figure A2):

Nomenclature

1. Area: Area of the bounding surface in µm².

2. Mean: The average gray value within the selection. This is the sum of the gray values of all the pixels in the selection divided by the number of pixels. The value is reported in calibrated units.
3. **Fit Ellipse:** An ellipse is fit to the selection. Major, Minor and Angle represents the primary and secondary axis of the best fitting ellipse. Angle is the angle between the primary axis and a line parallel to the x-axis of the image. Shape Descriptors (previously Circularity):

   Calculate and display the following shape descriptors

   a) **Circ. (circularity):** $4\pi \text{area}/\text{perimeter}^2$. A value of 1.0 indicates a perfect circle.

      As the value approaches 0.0, it indicates an increasingly elongated shape.

   b) **AR (aspect ratio):** Major axis/Minor axis.

   c) **Round (roundness):** $4\text{area}/(\pi \text{major axis}^2)$, or the inverse of the aspect ratio.
Appendix B: Porosity Measurement

Porosity of a sectioned scaffold is measured by using a light microscope at 40X magnification (Figure A3 (a)). The image is threshold in ImageJ using Image -> Adjust -> Threshold, Figure A3 (b). The image is analyzed for pore area using Measure-> Analyze Particles. Figure A3 (c) is an outline of all the pores. The area fraction between total area of the pores to scaffold area is measured as porosity.

Figure A3. a) Image acquired from light microscope, b) Threshold of image and c) Outline of pores generated from (b).
VITA

Revathy Subramanian

Candidate for the Degree of

Master of Science

Thesis: SPATIAL DISTRIBUTION OF CELLS WITHIN THE VOID VOLUME OF A CHITOSAN-COLLAGEN SCAFFOLD

Major Field: Chemical Engineering

Biographical:

Education:

Completed the requirements for the Master of Science in Chemical Engineering at Oklahoma State University, Stillwater, Oklahoma in July, 2012.

Completed the requirements for the Bachelor of Technology in Chemical Engineering at Anna University, Coimbatore, Tamil Nadu, India in 2007.

Experience:

Graduate Teaching Assistant, Department of Chemical Engineering, Oklahoma State University Aug 2010 to Dec 2011.

Assistant Systems Engineer at Tata Consultancy Services, Chennai, Tamil Nadu, India Jun 2007 to Jul 2009.

Professional Memberships:

American Institute of Chemical Engineers (AIChE)
In tissue engineering, cells must be uniformly distributed within 3D scaffolds in order to receive adequate nutrition and oxygen. The objective of this project is to test a novel method to seed cells within a three-dimensional porous chitosan-collagen scaffold to achieve a uniform cell distribution in the Z direction and XY plane. Cells mixed in a collagen solution are seeded to the top of the scaffold and centrifuged to distribute the cells throughout the void spaces of the scaffold. The scaffolds are placed in a CO₂ incubator at 37°C to allow the collagen-cell solution to gel, thus trapping the cells throughout the scaffold. The cells trapped in a collagen gel are observed for viability, proliferation, and distribution. Fluorescent microscopy is used to view the distribution of CellTracker red and DAPI-labeled cells within the scaffolds. Cell viability and proliferation in the scaffolds are compared to a two-dimensional monolayer cell culture and to cells distributed within three-dimensional collagen gels.

Findings and Conclusions:

The mean major pore size of the optimum dry scaffold is approximately 130 µm with a thickness of 800 µm. Preliminary observations show that the cells attach to the scaffold and are viable. Cell seeding efficiency of a scaffold or collagen gel is increased when seeded within a collagen solution. Due to the viscous nature of the collagen solution, a majority of cells are retained on the top surface of the scaffold. An increase in centrifugation increases cell penetration; however, with a decrease in cell viability.

A balance in the viscous nature of the collagen and the centrifugal force has led to a uniform distribution of cells throughout the scaffold. A collagen solution of 2 mg/ml results in the best cell distribution in the XY plane among the samples, but cell growth decreases. The optimum seeding method of those tested was with a collagen solution of 1 mg/ml and a centrifugal force of 840 x g (2200 rpm). This method provided a uniform distribution of cells in the Z direction and good cell viability and proliferation.